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User Notes
1.
This Case Study is intended to serve as an aid to agencies interested in preparing a request for EPA approval of a candidate Approved Regional Method (ARM) for PM2.5 ambient air monitoring under new (December 2006) regulations.  An ARM is defined as a continuous PM2.5 method that has been approved specifically within a State or local air monitoring network for purposes of comparison to the NAAQS and to meet other monitoring objectives.  To be approved, an ARM must meet the same basic performance criteria provided for PM2.5 Class III methods as described in Part 53, Title 40 of the Code of Federal Regulations (40 CFR Part 53, as amended December 18, 2006); however, the location of test sites, number of FRM and candidate ARM methods to operate and amount of data to collect are different compared to candidate Class III methods.   Specific requirements for test sites, number of FRM and candidate ARM methods to operate during testing, and the amount of data to collect, as well as information on the submittal process to EPA for a candidate ARM are provided in the regulatory provisions of Section 2.4 of Appendix C to Part 58, Title 40 of the Code of Federal Regulations (40 CFR Part 58, as amended December 18, 2006).  The EPA considers the merits and performance capabilities of a candidate ARM method based on the information and specific test results contained in the submitted request.  If the candidate method is found to satisfy all the applicable ARM requirements, the method is approved by the EPA as an Approved Regional Method under Part 58, Appendix C.  A method approved by the EPA as an ARM may be used, subject to conditions set forth in Section 2.4, within the State, Local, or Tribal air monitoring network in which it was tested.  An application for a candidate ARM that has not already been approved in another agencies network are submitted to EPA’s Office of Research and Development according to the instructions provided for in Appendix C to Part 58.  When an ARM has already been approved by EPA for use in a particular monitoring network, subsequent applications for approval in another monitoring network are submitted through the applicable EPA Regional Office.
 2.
This Case Study includes example paragraphs typical of the types of specific information, or of the nature of the information, that is required to be included in an EPA ARM approval request.  For an actual request for an ARM approval, these, or similar, paragraphs should be revised, rewritten, or augmented and tailored as appropriate to be specific for the particular subject candidate ARM.  In particular, the [bold, green text enclosed in brackets] is merely hypothetical example text and should be replaced with similar, appropriate text specifically related to the subject candidate method, or to its associated testing protocol and test results, for which the request is being prepared.
3.
The resource files, Part 53 Reg amendments.dot and Part 58 Reg amendments.dot, provide the formal ARM and approval request requirements in the actual Parts 53 and 58 regulation language for convenient reference.  The Case Study incorporates convenient hyperlinks to context-specific provisions of these regulations to confirm a particular requirement and to reference the details of the more complex requirements.  Note that these Part 53 and Part 58 resource files contain only the new provisions and amendments to 40 CFR Parts 53 and 58 that became effective on December 18, 2007 (unless otherwise indicated).  Generally, these new and amended provisions are the ones that are of principle concern in the preparation of ARM applications for Class III candidate methods for PM2.5.  However, some of the unrevised sections of Parts 53 and 58 may also be applicable, or may be of interest, as well.  The previously existing versions of Parts 53 and 58 (containing the non-amended sections) are available at http://www.access.gpo.gov/nara/cfr/cfr-table-search.html#page1.  The complete content of Parts 53 and 58, including the 12/18/06 amendments, should be available at this web site after July 1, 2007.
4.
For the links to the Parts 53 and 58 regulation language to work, the Part 53 Reg amendments.dot and Part 58 Reg amendments.dot resource files must reside in the same folder as this Case Study file.  These resource files (template files) will open automatically in Word when the first link is accessed as second and third documents along with this Case Study file (the first link that opens the document may not go to the correct place in the document).  Note: These files contain a small macro, and if you get a macro warning, you may safely enable the macro.  (To avoid the macro warning, you may set your Word macro security to “low” (Tools>Options>Security>Macro Security.)  For best use of these resource files, the “Document Map” should be visible on the left side.  If the document map is not there (because the macro was disabled), click on the View menu and then on Document Map to activate it.  The resource files have an outline structure, so that the Document Map may be used to go to specific sections, tables, figures, or equations or to collapse and expand various sections of the text.  It is also presented in a “web layout” view, so that both an Internet-type tool bar and the outline tool bar should be present and available for use.
5.
In the Case Study, section numbers in brackets ( [Section 2.4…] ) are hyperlinks directly to that section of the Part 53 or Part 58 regulation language on the resource files (Part 53 Reg amendments.dot or Part 58 Reg amendments.dot) and usually include tips with additional information. Other underlined blue text also offers tips and links to pertinent regulatory requirements or other potentially useful information.  After viewing a linked reference to the Part 53 regulation, the Internet-style “back” button 
[image: image1] may be used to conveniently return to this Case Study document.  Many links take you to other parts of the Case Study document; and to get a convenient “back” button 
[image: image2] to take you back to your previous place in this document, click on View>Toolbars and click on “Web.” 
6.
If this Case Study is used as a framework for the preparation of an actual EPA ARM application, it is suggested that one copy of the Case Study file be kept intact to serve as a reference and model, and a second copy might be revised and rewritten as necessary to tailor it to the subject candidate method and applicant.  As this is carried out, the bracketed section references and underlined hyperlinks should, of course, be deleted.
7.
The Case Study is structured to provide a basic skeleton to address the various different types of information required in an application.  No particular format or structure for this information is mandated by either Part 53 or Part 58, as long as all the required information is contained in the application and submitted. Although the body of this Case Study document with the example information paragraphs is rather modest in length, a substantial amount of other, more detailed information is required in the application.  This includes information regarding such aspects as the nature and design of the candidate method and its operating or instruction manual, the location information for the test site(s), details of the installation, calibration, and operation of the test instruments or samplers at each test site, the test data obtained at each test site, and hourly data obtained during the field tests.  The use of attachments to a base application framework, as suggested by this Case Study, is only one of perhaps other ways that this more detailed supplemental information may be included in the application.  While most information is typically expected to be in hard copy, certainly some types of information, e.g. test data, certainly might be better attached and submitted on some form of computer-readable electronic media.
8.
Questions regarding the submission of an ARM application or clarification of the ARM testing or other regulatory requirements should be directed to the Reference and Equivalent Method Program, MD D205-03, U. S. Environmental Protection Agency, Research Triangle Park, NC  27711  (Phone: 919-541-3737, e-mail: Hunike.Elizabeth@epa.gov).  See also the notice to potential applicants and the PM FEM FAQs as well as any other information or guidance documents that may be posted from time to time at www.epa.gov/ttn/amtic (Criteria Pollutants).
Request for Approval of a PM2.5 Candidate Approved Regional Method (ARM) Under 40 CFR Parts 58, Appendix C
1.  General Information
1.1  This request for approval of a candidate Approved Regional Method (ARM) is submitted to the Director, National Exposure Research Laboratory, Reference and Equivalent Method Program (MD-D205-03), U. S. Environmental Protection Agency, Research Triangle Park, North Carolina 27711 under 40 CFR Part 58, Appendix C, Sections 2.4.5 and 2.7.  The candidate method is a method for PM2.5 based on the [Fine Instrument Company’s Model XYZ-123 PM2.5 Ambient Air Monitor].  At this time, this method [has not been designated by the EPA as a Federal reference method (FRM) or equivalent method (FEM) under 40 CFR Part 53, and it is our belief that the method has not been approved as an ARM for any other monitoring agency’s monitoring network.] [40 CFR 58, Appendix C, Section 2.4]
1.2  This application is submitted by [Ms. Zelda E. Arnold] under her signature as [Director, Air Quality Division, Department of Environmental Management, State of Disarray, 41141 State Street, State Capital, DY  999999].  
[Zelda E. Arnold]
[Zelda E. Arnold, Director]
1.3  The candidate ARM will be used at [three] PM2.5 monitoring sites located in [Paradise, in the northwestern area of the State].  These monitoring sites are identified and described completely, along with information describing the nature and character of the particulate matter that is expected to occur in that area, in Attachment 1.  [Section 2.4.5.1]
1.4  The candidate ARM for which this request is submitted is the [Fine Instrument Company’s Model XYZ-123 PM2.5 Ambient Air Monitor].  This method is described in Section 2, below, and in the associated [Model XYZ-123 Operation and Instruction Manual (configured for PM2.5) (Attachment 5)] included as part of this request.   [Section 2.4.5.2]
1.5  Approval of an ARM to use at these sites is requested because [the PM2.5 concentrations at the proposed ARM sites are quite variable, and hourly data is needed to help determine the source apportionment so that control strategy can be developed, while also obtaining PM2.5 data that can be used to determine attainment of the NAAQS in the area.  To date, no continuous PM2.5 FEM that can be used for this purpose has been designated by EPA].  [Section 2.4.5.3]
1.6  Special quality assurance procedures have been developed for the candidate ARM, and these QA procedures will be implemented when the ARM is used at the proposed monitoring sites.  These QA procedures are described in detail in Attachment 2.  [Section 2.4.5.4]
1.7  Special procedures have also been developed for assessing the precision and accuracy of PM2.5 measurements obtained with the ARM at the proposed sites.  These assessment procedures are also described in Attachment 2 and are patterned after those for similar type automated PM methods given in Appendix A of Part 58.   [Section 2.4.5.5]
1.8  Comparability tests of the candidate ARM were carried out at one of the proposed sites at which the ARM will be used, as required.  These tests are described in Sections 3 and 4, below.  [Section 2.4.5.6]   
1.9  Descriptions of the test facilities, test configurations, the test data obtained, test records, calculations, and test results and other pertinent information are provided in Section 3, below, and in [Attachment 4].   [Section 2.4.5.7]
2. Description of the Candidate Method

2.1  [The Model XYZ-123 PM Monitor is an automatic beta attenuation type PM analyzer that can be configured with various inlets and particle size separators.  For this ARM approval request, the candidate analyzer is configured with a PM2.5 particle size separator to provide near-real time measurements of ambient concentrations of PM2.5.  This configuration is identified as the Model XYZ-123 PM2.5 Monitor and described completely in the Model XYZ-123 Operation and Instruction Manual (configured for PM2.5), which is included in this request as Attachment 6.  No physical or operational modifications are made to the instrument for the purpose of this ARM approval request.]

2.2  [Optional] Further, for this candidate ARM approval request, the PM2.5 measurements obtained from the ARM monitors at the two proposed sites at which the ARMs will be operated will be transformed to achieve improved comparability with FRM measurements at these sites.  A complete description of the ARM data transformations that will be used is provided in Attachment 3. 
2.3  As noted in paragraph 1.6, above, special quality assurance procedures, described in detail in Attachment 2, have been developed for the candidate ARM.  These QA procedures will be implemented when the ARM is used at the proposed monitoring sites, and the ARMs will be operated consistently at [the two sites].  Further, the ARM will be operated to provide hourly PM2.5 data, which will be aggregated into daily 24-hour average PM2.5 concentration measurements.
2.4  The candidate ARM utilizes [the louvered PM10 inlet specified for the PM2.5 FRM in 40 CFR 50, Appendix L, Figures L-2 through L-19 also the BGI VSCC™ Very Sharp Cut Cyclone PM2.5 particle size separator, which is also specified as an alternative separator for the PM2.5 FRM in 40 CFR 50, Appendix L (revised December 18, 2006), Section 7.3.4.4].  [Section 2.4.2.3]

2.5  The candidate ARM is fully amenable to flow rate auditing, and appropriate flow auditing procedures for the method have been developed and are described in Attachment 2, along with a recommended audit frequency as specified in Part 58, Appendix A.  [Section 2.4.2.4]

2.6  The data transformations that will be used for the ARM monitoring data at the proposed ARM monitoring sites, as described in Attachment 3, are fully described in [an addendum to this Agency’s Quality Assurance Project Plan (QAPP)].  [The transformations will be applied to the raw hourly reading obtained from the ARMs via electronic transmission, and both the raw and transformed readings will be stored by the DEM to allow for the possibility of correction in the event that an error is later discovered in the application of the transformation].  [Section 2.4.2.5]

2.7  As required, special procedures have been developed for assessing the precision and accuracy of PM2.5 measurements obtained with the ARM at the proposed sites, and these procedures will be implemented at the ARM monitoring sites.  The assessment procedures are described in Attachment 3 and are patterned after those for similar type automated PM methods given in Appendix A of Part 58, with generally the same frequencies and calculation.  [Section 2.4.3]
3.  Description of the Field FRM Comparison Test (Part 53, Subpart C)  

3.1  [The Model XYZ-123 PM2.5 Monitor] was tested for comparability to the PM2.5  reference method at [three (for first ARM application), or two (for all others)] the monitoring sites proposed for use of this ARM.  The test site location and the other site location where the ARM will be used are identified and described in [Attachment 1], along with pertinent information, data, and a narrative summary to describe the nature and characteristics of the site.  [Sections 2.4.1, 2.4.1.1]

3.2  The FRM  samplers were installed, calibrated, and subsequently operated in accordance with 40 CFR Part 50, Appendix L, with its manufacturer’s operation and instruction manual, and with applicable portions of “Quality Assurance Document 2.12.”    The [Model XYZ-123 PM2.5 Monitor] were setup, calibrated, and operated in accordance with the [Model XYZ-123 Operation and Instruction Manual (configured for PM2.5)], a copy of which is included in this application as Attachment 6.


3.3  Information regarding the calibration of the FRM sampler and the candidate ARM, the calibration data, and the calibration standards used in calibrating the test instruments is contained in Attachment 4.

3.4  The comparability tests at the test site were conducted over a one year period from [March, 2007 to February, 2008] with at least 20 valid data points per season, as required and as shown in the test data presented in Attachment 5.  [Section 2.4.1.2]    [Section 2.4.1.6]

3.5  Since only one candidate ARM monitor was used in the comparability tests, no precision could be determined for the candidate method from the test data.  However, QA data obtained from AQS for other monitoring sites where the candidate method has been operated were used to estimate precision for the candidate ARM.  The same data transformations proposed for this candidate ARM were applied to these AQS data, and the procedures and formulas of Subpart C, section 53.35(f) were used in determining the method precision.  The precision calculations are presented in Attachment 5 in the form of a spreadsheet.  The precision thus determined met the Part 53, Subpart C requirements for candidate method precision.  [Section 2.4.1.4]

3.6  As noted in Section 2 above, data transformation of the data from the candidate ARM are proposed to be used for the monitoring data obtained at the three proposed monitoring sites, and the data transformation algorithms are intended as an integral part of the candidate ARM.  Details of the data transformation are presented in Attachment 3.  [Section 2.4.1.7]
4.  Field Comparison Test Data and Test Calculations

4.1  During the full-year field comparison, the ARM operated continuously, and the FRM sampler was operated [every 3rd day.  This resulted in 122 pairs of corresponding ARM and FRM measurements, with at least 30 in each season of the year.  Therefore, the test data met the minimum valid data requirements of Section 2.4.1.5, and no data were excluded because the FRM measurement was less than 3 μg/m3.

4.2  The FRM sampler was operated on the standard midnight-to-midnight, every-3rd-day schedule used at other monitoring sites in the DEM PM2.5 monitoring network.  FRM filters were retrieved within the required filter retrieval period after each sample day, stored and transported to the Agency’s weigh laboratory in an ice cooler, and kept in refrigerated storage at the weigh laboratory, where they were weighed periodically along with routine monitoring network FRM samples obtained from other sites.  Filter handling and other aspects of the FRM test measurements were in accordance with our standard Agency SOPs and in compliance with the FRM reference method and in general accordance with “Quality Assurance Document 2.12.”


4.3  Collocated measurements were obtained by the candidate ARM in accordance with the [Model XYZ-123 Operation and Instruction Manual (configured for PM2.5) (Attachment 6)] and as described in Section 3, above.   Monitoring data corresponding to the days that the FRM operated were selected for the comparison study and entered into an Excel spreadsheet.  Both the hourly averages from the candidate ARM and the derived 24-hour averages [for the days that the FRM operated] are included in the spreadsheet.  The appropriate transformation was applied to these 24-hour averages, and the transformed data were entered into the EPA-provided spreadsheet, PM ARM test data template.xls, along with the corresponding FRM data.  All spreadsheets are included in this request as Attachment 5.  Calculations shown in the spreadsheet indicate that the candidate ARM met the requirements for additive and multiplicative bias and for correlation during the test period.
5. Attachments
[Attachment 1
Test site locations and descriptive information]

[This attachment should include details and documentation to describe the nature of the site location(s) where the ARM(s) will be used, including maps or other information to identify location(s), photos or other information to describe the nature and character of each site, and other information as may be appropriate. The latter may include a narrative description supplemented with recent, nearby pollutant measurements, weather and climatic data characteristic of the site, emission inventory data or a description of predominant pollutant sources in the area, and the influence of particularly nearby sources or obstructions.]  
 [Attachment 2 
Quality assurance procedures for the candidate ARM


[This attachment should describe the quality assurance procedures that have been developed for the candidate ARM and that will be implemented when the ARM is used at the proposed sites.  These QA procedures should be similar and generally consistent or parallel with the QA procedures in Appendix A of 40 CFR Part 58. ]

[Attachment 3
Data transformations

[This attachment should describe in detail any transformations of the measurement data obtained from the candidate ARM and show exactly how the transformed measurements will be determined and implemented, including any additional site condition monitors or other input data that is used in or is a part of the transformation.]
[Attachment 4
Instrument calibrations, calibration data, calibration standards, and other test documentation]


[This attachment should contain the documentation of all pertinent details of the test setup at the test site, including diagrams or other information on the arrangement and installation of both the candidate method instrument(s) and the FRM sampler(s), records of the calibration of each instrument or sampler, certifications of the calibration standards used, operational protocols for each test instrument and sampler, qualifications of the instrument operator(s), and full details and explanation of any malfunctions, service or repair requirements, unusual circumstances or occurrences, or any events that may have an effect on the test data obtained and what such effect might be.]
[Attachment 5
Comparability test data] 

[This attachment should contain the actual test data obtained in the comparability tests at each site.  The data may be submitted on paper, but more typically would be submitted in a spreadsheet or other appropriate data format on a CD or other electronic medium.  It is suggested that the EPA-provided spreadsheet (PM ARM Test data template.xls) be used to submit the test data, using a separate copy of the spreadsheet for each site, as this spreadsheet is pre-programmed with a suitable data format and also automatically carries out some of the required checks and test calculations using the test data. This special spreadsheet may be downloaded from the EPA website at www.epa.gov/ttn/amtic (Criteria Pollutants) and may be modified, if necessary, to accommodate the nature of the test data.   If the EPA spreadsheet is not used, the various calculations for each test should be carried out by other means and reported along with the test data.  All calculations should be shown in sufficient detail so that they can be verified.]
[Attachment 6
Model XYZ-123 Operation and Instruction Manual (configured for PM2.5)]

[The Operation and Instruction Manual is a very important part of the candidate ARM.  Section 53.4(b)(3) of the Part 53 regulation describes the nature and extent of the content material that this Manual should include.]
PAGE  
ii

[image: image3.png]|



